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Introduction

This manual is intended to describe the characteristics, operation, calibration, andmaintenance of the AquaTROLL 100 and
AquaTROLL 200 Sondes.

System Description

The Aqua TROLL® Instrument is a compact, modular system for measuring conductivity and temperature in natural
groundwater and surface water, as well as industrial, wastewater, and other installations. Aqua TROLL 200 Instruments have
the added capability of measuring level. Components include the instrument, vented and non-vented cables, communication
cables, external power accessories, desiccants, and other installation accessories, calibration solutions, and software.

How to Use This Manual

This Operator’s Manual is designed as a start-up guide and a permanent reference for Aqua TROLL 100 and 200 Instruments.

l Section 1: Introduction to the Aqua TROLLOperator’s Manual and to In-Situ Inc. —Warranty provisions —
Instrument repair & return recommendations

l Section 2: System Components —Accessories —Product specifications

l Section 3: Getting Started—Attaching cable— Installing and opening the software

l Section 4: UsingWin-Situ—Connecting for the first time—Customizing the Home screen—Setting the clock —
Setting a device site—Calibrating conductivity —Preparing to log data—Disconnecting

l Section 5: The Conductivity Sensor: Description—Calibration—Available parameters

l Section 6: The Pressure (Level) Sensor: The two basic types of pressure sensors —Factory and field calibration

l Section 7: Field Installation—Guidelines and precautions for long-term deployment of the Aqua TROLL
Instrument

l Section 8: Connecting for Use with SDI-12, Analog (4-20mA), andModbus Loggers and Controllers

l Section 9: Care andMaintenance

l Section 10: Troubleshooting

Conventions

Throughout this operator’s manual you will see the following symbols.

Certification

The Aqua TROLL Instrument complies with all applicable directives required by CE and the FCC and found to comply with
EN 61326, ICES-003, and FCC Part 15 specifications. Declarations of conformity may be found at end of this manual.
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Unpacking and Inspection

Your Aqua TROLL Instrument was carefully inspected before shipping. Check for any physical damage sustained during
shipment. Notify In-Situ and file a claim with the carriers involved if there is any such damage; do not attempt to operate the
instrument. Accessories may be shipped separately and should also be inspected for physical damage and the fulfillment of
your order.

Serial Number

The serial number is engraved on the body of the instrument. It is also programmed into the instrument and displayed when
the instrument is connected to a computer runningWin-Situ® 5 or to amobile device with VuSitu software. We recommend
that owners keep a separate record of this number.

To Our Customers

Thank you for your purchase of an In-Situ product. We are glad you chose us and our products to help you with your
environmental monitoring needs. In-Situ Inc. has been designing andmanufacturing world-class environmental monitoring
instrumentation for over 25 years in the Rocky Mountains of the United States. As it was in the beginning, our expectation is
that this product will provide you with many troublefree years of use. To that end, we pride ourselves on delivering the best
customer service and support possible—24 hours a day, 7 days a week. We believe that this level of commitment to you, our
customer, is imperative in helping you ensure clean, safe groundwater and surface water resources around the globe. We
also understand the need for accurate, reliable assessments and we continue tomake significant investments in Research
and Development to ensure that we deliver the latest product and technological innovations to support your needs.

Whether you are gathering information about a body of water for a few moments, or over a period of years, you can rely upon
us to provide you with a quality product and outstanding customer support at a fair price and have that product delivered to
you when and where you need it.

Wewant your experience with In-Situ Inc. to be pleasant and professional, whether you are renting or purchasing from us.
Wewould be pleased to hear from you and to learnmore about your needs and your experiences with our products. Again, we
thank you for choosing In-Situ Inc. and we look forward to serving your needs now, and in the future.

Warranty Provisions

In-Situ® Inc., (In-Situ) warrants that all new Aqua TROLL® 100 and 200 Instruments shall be free from defects in materials
and workmanship for a period of two years when properly installed and operated in accordance with the instructionmanuals
provided by, or available through, In-Situ Inc., and when used within the design specifications for the product. Products and
accessory products including batteries, which aremanufactured by others, carry the warranty of that manufacturer, or 30
days, whichever is greater. The warranty period for all products begins on the day the product is shipped to the customer or
distributor. The completeWarranty Policy is available on the In-Situ website.

How to Contact Us

Technical Support 1-800-446-7488, option 3
Toll-free 24 hours a day in the U.S.A. and Canada
Address: In-Situ Inc.

221 East Lincoln Ave.
Fort Collins, CO 80524 U.S.A.

Phone: 970-498-1500
Fax: 970-498-1598
Internet: www.in-situ.com
email: support@in-situ.com
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To Obtain Repair Service

If you suspect that your instrument is malfunctioning and repair is required, you can help ensure efficient servicing by
following these guidelines:

1. Call or e-mail In-Situ Technical Support (support@in-situ.com). Have the equipment with you when you call.

2. Be prepared to describe the problem, including how the instrument was used and the conditions noted at the time of the
malfunction.

3. If Tech Support determines that service is needed, they will ask that you download and complete a ReturnMaterials
Authorization Form available on the In-Situ website under Contact/Returns for Service.

4. Clean the instrument and cable. Decontaminate thoroughly if it has been used in a toxic or hazardous environment. See
"Guidelines for Cleaning Returned Equipment" on page 6

5. Remove all sensors and accessories that are not required for the repair prior to returning unit.

6. Mark the RMA number clearly on the side of the box with amarker or label. Please keep your RMA number for future
reference. Return unit for repair to the following address:

In-Situ Inc. Attn: RMA #XXXXX

221 E. Lincoln Ave.

Fort Collins, CO 80524

U.S.A.

To reduce waste, please use your original shipping container, if it is in good condition. The warranty does not cover damage
during transit. We recommend the customer insure all shipments. Warranty repairs will be shipped back prepaid.

Guidelines for Cleaning Returned Equipment

Please help us protect the health and safety of our employees by cleaning and decontaminating equipment that has been
subjected to any potential biological or health hazards, and labeling such equipment. Unfortunately, we cannot service your
equipment without such notification. Please complete and sign the form on page 7 (or a similar statement certifying that the
equipment has been cleaned and decontaminated) and send it along to us with each downhole instrument.

• We recommend a cleaning solution, such as Alconox®, a glassware cleaning product available from In-Situ (Catalog No.
0029810) and laboratory supply houses.

• DO NOT remove the nose cone. DO NOT use any object to clean the sensor face.

• Clean the pressure sensor by soaking only in cleaning solution or clean water.

• Clean all cabling. Remove all foreignmatter.

• Clean cable connector(s) with a clean, dry cloth. Do not submerge.

• Clean the probe body—including the nose
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Decontamination and Cleaning Statement

If an instrument is returned to our Service Center for repair or recalibration without a statement that it has been cleaned and
decontaminated, or in the opinion of our Service Representatives presents a potential health or biological hazard, we reserve
the right to withhold service until proper certification has been obtained.

Company name Phone
Address
City State Zip
Instrument Type Serial Number
Contaminants (if known)

Decontamination procedure used

Cleaning verified by Title
Date
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System Components

Instrument

The completely sealed Aqua TROLL Instrument contains conductivity and temperature sensors, real-time clock,
microprocessor, sealed lithium battery, data logger, andmemory. Aqua TROLL 200 Instruments include a vented or non-
vented pressure sensor in a variety of ranges.

Cable

Several basic cable types are used in the Aqua TROLL system.

l RuggedCable® System, TPU-jacketed (Thermoplastic Polyurethane), vented or non-vented

l Vented Tefzel®-jacketed cable (ETFE fluoropolymer)

l Poly-coated stainless steel suspension wire for deployment of a non-vented instrument

l Communication cables for programming the device/ downloading the logged data

RuggedCable System
Cable includes conductors for power and communication signals, a weight-
bearing structure, and a Kellems® grip to anchor the Aqua TROLL Instrument
securely. Cable is available in standard and custom lengths. Uphole and
downhole ends are identical female twist-lock connectors that connect to the
Aqua TROLL Instrument, cable connect TROLL® Com devices, desiccants and
other accessories.

Vented cable must be used with vented pressure/level sensors on the Aqua
TROLL 200 to achieve gauged measurements. The cable vent tube ensures that
atmospheric pressure is the reference pressure applied to the sensor diaphragm.

Vented cable ships with a small desiccant cap that should be replaced with
a larger volume desiccant before you deploy the instrument in a humid
environment.
Non-vented cable may be used with non-vented pressure/level sensors on the
Aqua TROLL 100 or 200 Instruments to achieve absolute measurements. Vented
cable can also be used.
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RuggedCable Stripped-and-Tinned
In place of the uphole twist-lock connector, this cable ends in bare conductors for
wiring to a logger or controller using SDI-12, analog (4-20 mA), or Modbus
communication protocols. Vented cable includes an outboard desiccant to protect
against condensation.

Also available in a shorter length ending in a male twist-lock
connector to mate with RuggedCable.

See "Analog, SDI-12 and Modbus Connections" on page 46

Suspension Wire
Poly-coated stainless steel suspension cable is ideal for deployment of
instruments with non-vented pressure sensors.

Small Desiccant

Vented cable includes a clear cap of indicating silica desiccant to protect the cable and
electronics from condensation during shipping. In humid environments, replace the
small desiccant with a larger-volume desiccant before deploying the instrument.
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Large Desiccant

The optional high-volume desiccant pack attaches to vented cable and is available with
a titanium or plastic twist-lock connector. Refill kits are available from In-Situ Inc. or your
distributor.

Outboard Desiccant

Vented stripped-and-tinned cable includes an outboard desiccant pack attached to the
cable vent tube, and is the same size as the large desiccant. Replacements and refills
are available.

Accessory Catalog No.
Small desiccant (3) 0052230
Large desiccant, ABS connector 0053550
Large desiccant, titanium connector 0051810
Outboard desiccant (replacement) 0051380
Refill kit for large & outboard desiccant 0029140
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Communication Cables

TROLLCom devices enable an instrument to communicate with a desktop/laptop PC ormobile device
for profiling, calibrating, programming, and downloading. TROLLCom devices include 0.9m (3 ft)
vented polyurethane cable, external power input jack, and a vent with replaceablemembrane.

TROLL Com (Cable Connect)

Connects a RuggedCable to a serial or USB port. It is weatherproof and withstands a temporary
immersion (IP67).

TROLL Com (Direct Connect)

Connects an Aqua TROLL Instrument directly to a serial or USB port. It is a good choice for permanent
connection to a PC, or for programming a non-vented Aqua TROLL Instrument that will be deployed
without RuggedCable. It is not submersible.

Wireless TROLL Com

Connects an Aqua TROLL instrument to amobile device running VuSitu or to a PC withWin-
Situ 5 software.

Accessory Catalog No.
Wireless TROLL Com 0031240
RS232 TROLL Com, Cable Connect 0056140
USB TROLL Com, Cable Connect 0052500
RS232 TROLL Com, Direct Connect 0056150
USB TROLL Com, Direct Connect 0052510

Power Components

Internal Power
The Aqua TROLL Instrument operates on 3.6 VDC, supplied by a sealed, non-replaceable AA lithium battery. Battery life
depends on sampling speed. The battery typically lasts for 5 years or 200,000 readings, whichever occurs first. One reading
is defined as date, time, and all available parameters polled or logged from the device.

External Power
External Battery Pack
The sealed, submersible TROLL Battery Pack (lithium) supplies 14.4 V. When this power source is connected, the
Aqua TROLL Instrument will use the external battery source first and switch to the internal batteries when external
battery power is depleted. Typical external battery life when logging all available parameters at 2-minute intervals is
approximately 2 years.

AC Adapter
In-Situ’s AC adapter provides 24 VDC, 0.75 A, AC input 100- 250 V, includes North American power cord. The
Programming Cable includes an external power input for connection to this adapter.
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Accessory Catalog No.
External Battery Pack 0051450
AC Adapter 24V 0052440

Installation Accessories

Twist-Lock Hanger
Titanium hanger to seal and suspend a non-vented Aqua TROLL
Instrument while taking data; no venting, no communication capabilities

Catalog No. 0051480

Cable Extender
Connects two lengths of RuggedCable

Catalog No. 0051490

Wellcap
Locking and vented

2" Locking Wellcap:
Catalog No. 0020360

2" Vented Locking Wellcap:
Catalog No. 0020370

4" Locking Wellcap:
Catalog No. 0020380

4" Vented Locking Wellcap:
Catalog No. 0020390

Top of Well Installation Ring
Catalog No.
Well-dock 2", 4" or 6"

Bulkhead Connector
Panel-mounted bulkhead for connection to RuggedCable

Catalog No. 0053240
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Product Specifications- General

Aqua TROLL 100 and 200 Instruments

Temperature ranges1 Operational: -5 to 50° C (23 to 122° F)
Storage: -40 to 65° C (-40 to 149° F)
Calibrated: 0 to 50° C (32 to 122° F)

Max Pressure for Aqua TROLL 100 500psi (1153 ft)

Dimensions and weight Diameter (OD): 1.83 cm (0.72 in)
Length: 31.5 cm (12.4 in)
Weight: 188 g (0.41 lb)

Materials Titanium body and sensors; Delrin nose cone;
PVC conductivity cell

Output options Modbus/485; SDI-12; and 4-20 mA

Battery type and life2 3.6V lithium; 5 years or 200,000 readings3

External power 8-36 VDC

Memory
Data records4
Data logs

4 MB
190,000
50

Log types5 Linear, Linear Average and Event

Fastest logging rate Linear: 1 per minute. Linear Average: 1 per minute.
Event: 1 per second

Fastest output rate 1 per second

Product Specifications- Conductivity Sensor

Conductivity Sensor Type: Balanced 4-electrode cell

Methods EPA Method 120.1; Standard Methods 2510

Range, accuracy and resolution Range: 0 to 100,000 µS/cm
Accuracy: ±0.5% of reading + 1 µS/cm when reading less than
80,000 µS/cm ±1.0% of reading above 80,000 µS/cm
Resolution: 0.1 µS/cm

Parameters supported6
Actual conductivity
Specific conductivity7
Salinity8
Total dissolved solids
Resistivity
Density (water salinity)

Range:
0 to 100,000 µS/cm
0 to 100,000 µS/cm
0 to 42 PSU
0 to 82 ppt
10 to 200,000 Ohms-cm
0.98 to 1.14 g/cmᶟ

Units:
µS/cm, mS/cm
µS/cm, mS/cm
PSU
ppt, ppm
Ohms-cm
g/cmᶟ
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Product Specifications- Pressure (Aqua TROLL Instrument)

Pressure/Level Sensor9 Type: Piezoresistive; Pressure/level are
available only to the Aqua TROLL 200
Instrument

Range Absolute (non-vented)
30 psia: 11 m (35.8 ft)
100 psia: 60 m (197 ft)
300 psia: 200 m (658.7 ft)
500 psia: 341 m (1120 ft)

Gauged
(vented)
5 psig: 3.5 m
(11.5 ft)
15 psig: 11 m
(35 ft)
30 psig: 21 m
(69 ft)
100 psig: 70 m
(231 ft)
300 psig: 210 m
(692 ft)
500 psig: 351 m
(1153 ft)

Burst pressure Maximum 2x range; burst 3x range

Accuracy (FS)10 ±0.05%11

Resolution: 0.005% FS or better

Long-term stability12 < 0.1% FS

Units of measure Pressure: psi, kPa, bar, mbar, mmHg, inHg,
cmH2O, inH2O)
Level: in, ft, mm, cm, m

Product Specifications- Temperature

Temperature Sensor13

Method EPA Method 170.1

Accuracy and resolution Accuracy: ±0.1° C or better

Units of measure Celsius of Fahrenheit

Product Specifications- Footnotes

1Temperature range for non-freezing liquids

2Typical battery life when used within the factory-calibrated temperature range

31 reading = date/time plus all available parameters polled or logged from device

41 data record = date/time plus 3 parameters logged (no wrapping) from device
5External power or battery pack is recommended when using Linear Average or Event loggingmodes
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6Parameters derived from temperature at 25° C and actual conductivity range of 0 to 100,000 µS/cm with a ±0.5% + 1 µS/cm
accuracy
7Derived from StandardMethods 2510B

8Defined by the Practical Salinity Scale 1978; StandardMethods 2520B

9Real-time level compensation based on water density

10Accuracy with 4-20mA output option: ±0.25% FS

11Across factory-calibrated pressure and temperature ranges

12Includes linearity and hysteresis over one year
13Temperature response varies by temperature change and environmental conditions in typical field conditions. T95 > 5min.

Specifications are subject to change without notice.
Delrin is a registered trademark of E.l. duPont de Nemours and Company.
NIST is a registered trademark of the National Institute of Standards and Technology.

Control Software

Win-Situ 5

Win-Situ® 5 Software is easy-to-use software for programming Aqua TROLL Instruments. Win-Situ provides instrument
control for direct reads and profiling, calibration, long-term data logging, data downloads, data viewing, data export to popular
spreadsheet programs, choice of units and other display options, and battery/memory usage tracking. Win-Situ® Plus
enables configuration of networks and telemetry. Minimum system requirements: 400MHz Pentium® II processor; 128MB
RAM, 100MB free disk space; Internet Explorer® 6.01 or higher; Windows® 2000 Professional SP4 or higher, Windows XP
Professional SP2 or higher, orWindows Vista SP1 or higher; Windows 7 or higher, CD-ROM drive; serial or USB port.

Accessory Catalog No.
Win-Situ 5 (no license required) 0051980
Win-Situ 5 Plus license 0053560

About VuSitu

VuSitu is themobile user interface and control application for In-Situ water quality instruments. You can use VuSitu onmobile
devices with Android operating system 4.4, Bluetooth 2.0 and newer. Download the latest version of the app from theGoogle
Play Store at play.google.com.

VuSitu allows you to accomplish the following tasks.

l View live readings that update every 10 seconds

l Change parameters and units

l Set up a data log

l Record data

l Email data in spreadsheet format

l Download data tomobile device

l Transfer data frommobile device to a computer

l Organize data by Location

l Calibrate Sensors and View Reports
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Getting Started

This section provides a quick overview of the initial steps necessary to get the instrument ready to communicate:

l Select the appropriate TROLLCom for communication. This determines the hardware connections, andmay
influence the software installation. The drawing on the following page shows the function of the different TROLL
Commodels.

l Install the software.

l Connect the hardware, based on the selected TROLLCom.

l Open the software and establish communication with the Aqua TROLL Insturment. See "UsingWin-Situ® 5
Software" on page 23 for an overview of Win-Situ operations.

Select a TROLL Com for Communication

The figure below shows the function and compatibility of the different models of cable and direct-connect TROLLComs.

TIPS: A Direct Connect TROLLCommay be preferred for
programming an Aqua TROLL Instrument that will be deployed on wire.

RuggedCable and a Cable Connect TROLLCom are required for
communication with the device while deployed, but programming can be
done with any TROLLCom connection.

Connect the Hardware

1. Connect the Aqua TROLL Instrument to the selected TROLLCom as
illustrated earlier in this section.

l Direct Connect:Attach via push-on connection to the Aqua TROLL
back end.

l Cable Connect:Connect the twist-lock connectors on the Aqua
TROLL Instrument and the RuggedCable.

2. Insert the TROLLCom into the computer port.

USB TROLL Com

When you plug in a USB TROLLCom, the USB drivers that were
downloaded when you installedWin-Situ 5 will be installed.

l After installation, check as follows to find which COM port the
connected USB TROLLCom is using:

l Windows 2000, Windows XP: Control Panel > System > Hardware tab > DeviceManager > Ports. Click the plus
sign to display the ports.

l Windows Vista and 7: Control Panel > System > DeviceManager (Administrator permission required) > Ports.
Click the plus sign to display the ports.

After connections aremade, you are ready to launch the software and program the Aqua TROLL Instrument. See "UsingWin-
Situ® 5 Software" on page 23. For more detailed information, see theWin-Situ Helpmenu.

Twist-Lock Cable Connections

1. Remove the protective caps from the Aqua TROLL connector end and cable connector end.



1-970-498-1500 17 www.in-situ.com

TIP:Retain the dust caps to protect the pins andO-ring from damage when cable is not attached.

2. Look at the connectors. Each has a flat side.

Note the pins on the instrument connector (one on each side) and the slots on the cable connector (one on each side).

3. Slide back the sleeve on the cable connector.

4. Position the flat edges so they will connect properly, and insert the instrument connector firmly into the cable connector.

5. Slide the sleeve on the cable toward the Aqua TROLL until the pin on the probe fits into the round hole in the slot on the
cable connector.

6. Grasp the textured section of the cable connector in one hand and the Aqua TROLL in the other. Push and twist firmly so
that the pin on the body connector slides along the slot on the cable connector and locks securely into the other hole.
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7. To attach a Cable Connect TROLLCom, first remove the desiccant from the cable by grasping the textured section of the
cable connector in one hand and the desiccant in the other. Twist in opposite directions to unlock the desiccant from the
cable.

Tip: Make sure you hear the “click.” The “click” ensures the cable is securely attached.

8. Position the flat edges so they will connect properly, and insert the TROLLCom connector firmly into the cable connector.

9. Push, twist, and click to lock.

Connecting a Cable to the Wireless TROLL Com

The twist-lock cable attaches to theWireless TROLL Com in the samemanner as above.

Connecting Your Instrument to VuSitu

To use VuSitu, you will need a Bluetooth-enabledmobile device, aWireless TROLL Com and a deployment cable.

Attach one end of the cable to theWireless TROLL Com and secure the other end to the instrument. Press the power button
on theWireless TROLL Com and open the VuSitu mobile app on your phone or tablet.

VuSitu will automatically search for Bluetooth devices nearby, but you will need to select the correct instrument when
connecting for the first time. Select Choose or Add a Device. You should see the serial number of the instrument you wish
to pair. Tap the serial number to connect. Tap theBack button on your device to view the Connected Instrument screen.
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VuSitu Menu Options

The features available in the VuSitu mobile app vary slightly depending on the instrument to which it is connected. Tap the
menu icon in the upper left portion of the screen to view the features included in VuSitu. Tap themenu icon again to close the
menu.

Menu Options when Connected to Instrument

Some features, such as sensor calibration, are not available when you are not connected to an instrument.

Live Readings Screen

The live readings screen displays instrument readings when the app is connected to the communication device and/or to the
instrument via Bluetooth.
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1 Main Menu

2
Selected Location

(Tap to change Location.)

3

Live Readings (scrollable)

Tap the settings wheel next to
each to change parameters and
units.

4
Tap to record readings

(Readings refresh every 10
seconds.)

Changing Parameters and Units

1. From the Live Readings screen, tap the settings wheel next to the field that contains themeasurement value.
When you release, the Parameter and Unit menu appears.

2. Tap the parameter drop-down arrow and tap the parameter you want to display.
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3. Tap the units drop-down arrow and tap the unit you want to display.

4. Tap theOK button to set the options and return to the Live Readings screen.

Record Data

1. From the Live Readings screen, tap Start Recording. A new set of readings is updated every 10 seconds and a
counter of readings is displayed in the Stop button.

2. It is optional to mark a set of readings by tapping theMark button.

3. When you have gathered enough data, tap the Stop button.

4. The recorded data appears on screen. If you havemarked data it will appear as a highlighted row.

5. If you want to return to the Live Readings screen, tap the Close button. (Your data can be accessed later in the
Data section of the app.)

Downloading and sharing your data.

You can download VuSitu data as an HTML file and share it via email, SMS or a cloud storage service such as Google Drive.
To download a log, select it from the Downloaded Data screen and tapSave to.
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Choose one of the download options from themenu. You can transfer a data file from your mobile device to a PC via
Bluetooth, email it to yourself or any valid email address, save the file to the VuSitu folder on your device or upload it to
Google Drive.

View your data in any web browser by double-clicking the file. You can then export a CSV file by clicking theExport a CSV
link at the top of the page.
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Using Win-Situ® 5 Software

Win-Situ 5 Software is theWindows PC-based In-Situ instrument control software for Aqua TROLL Instruments. UseWin-
Situ to:

l Display real-time readings from the connected Aqua TROLL, in meter, tabular, or graphic format

l Program the device to log data; download the logged data

l Calibrate the conductivity sensor, select output parameters and units

l Customize the output of a pressure/level sensor to record drawdown, surface water elevation, gauge height, stage
height, etc.

l Set communication options in the device—Modbus, SDI- 12, analog, IP, telemetry, etc.

Launch the Software and Connect Instrument

1. Start Win-Situ by double-clicking the shortcut created on the desktop during installation. Win-Situ opens and
displays the Data area (“Data tab”), shown below.

2. Check the COM port. The softwaremay ask if you want to select a COM port. Do one of the following:

l Answer Yes to the prompt, then check or change the port in the Comm Settings dialog, and click OK to
close it, or

l Answer No to bypass this step.

3. Win-Situ asks if you want to connect to the device. If the Aqua TROLL instrument is connected to your computer as
described in the previous section, answer Yes.

4. Software connects and displays a reading of all supported parameters.
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Bluetooth & Wireless TROLL Com

Connect the cable to theWireless TROLLCom and the Aqua TROLL 100-200 instrument. Turn on theWireless TROLLCom
and openWin-Situ 5. Choose File > Connect to access the Default Communication Settings window.

Select the radio button labeledBluetooth Communications and click Configure Bluetooth Devices. You will see a list of
nearby Bluetooth devices. Click theWireless TROLLCom you are using and click the check mark.
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Finally, click the yellow Connect button at the bottom right of the screen to complete the connection.

The Home Screen

l Note the Tabs at the top of the screen—this is the Home tab, which displays current readings from the connected
device.

l The Dashboard (status area) shows the devicemodel & serial number, battery andmemory usage, clock, alarms,
and logging status.

l The Control Panel contains action buttons. To update the readings in real time, press .

Note:When this button looks pressed in , polling is active. Before you can perform certain software tasks,
you will need to stop polling by pressing the button again.

Customizing the Home Screen

Changing Units

1. Click the Sensors tab , select the sensor for which you intend to change units.

2. Click the “Configure” button in the control panel.

3. In the Sensor Setup screen, select a parameter, then select a unit. Repeat for each
parameter as necessary.

4. Click OK to return to the Sensors tab.

Changing the Rate at Which the Readings Update

Also called the “poll rate,” this can range from 1 to 30 seconds.

1. Select Preferences > HomeView Settings.

2. Adjust the Poll Rate. Default: 5 seconds.

Changing the Decimal Places Displayed

To change the number of decimal places displayed for each reading:

1. Select Preferences > General Settings.

2. Under Parameter Defaults, select a parameter, then the “significant decimal digits” for each parameter.

Real-Time Graphing

To view a real-time trend graph: click the “Graph” button

To view a graph with a data table below it, select Preferences > Graph Settings. Check the Data Panel option. Click OK.

Set specific information in the software. Win-Situ provides many options. At aminimum:
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l Set the Aqua TROLL clock.

l Enter a name for the site where the instrument will collect data.

l Calibrate the conductivity sensor.

l Enter data logging instructions.

A brief overview is provided here. For more detailed information, see theWin-Situ Helpmenu.

Set the Clock

Data collection schedules depend on the device’s real-time clock. Both the device clock and the system (PC) clock are
shown on the dashboard. The clocks update every 2 seconds. If the device clock differs by more than 2 seconds from the

system clock, the device clock is displayed in red. To synchronize the clocks, click the “Sync” button .

Add a Site

Logged data are organized and filed by the site where the data were logged. This feature can help youmanage data from
multiple sites. You can create as many sites as you like, with or without an Aqua TROLL connected. Sites are stored in the
site database in yourWin-Situ working directory and are available to select for any Aqua TROLL, any log. You will need a site
when setting up a data log. Here are the steps to set up a new site:

1. On the Data tab, click the Site Data folder.

2. Select File menu > New > Site.

TIP:A default site is supplied andmay be used, but it does not contain any specific information on the location data
collection site. For more information on sites, seeWin-Situ Helpmenu.
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TIP:You can also create a Site Group to organizemultiple sites within a Site Group folder.

3. In the Site Information screen, enter a name for the site. A short, descriptive name is best—for example, a project, well,
water body, gauging station, town, nearby landmark, etc. Length is limited to 32 characters.

A site name is the only required field, but there aremany additional options for identifying a site. To include site Coordinates,

check Coordinates, then enter Latitude (0.00 to 90.00, select North or South from listbox), Longitude (0.00 to 180.00,
select East orWest) and Elevation (select Feet or Meters). You can add a short descriptive Note, import a site Photo
(bitmap), and/or specify a custom Connection. (If any connections have been defined, they will be displayed.)

4. When finished, click Save to save the site.

The new site will
appear in the Site
Data folder, and
Win-Situ will add it
to the site database
in the working
directory on your computer. It is now available to select for any device, any log.
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5. To set this new site in the connected Aqua TROLL Instrument: Return to the Home tab, click the down arrow beside the
site box, and select your new site. This site now becomes the “current” site for the connected Aqua TROLL Instrument, and
is available to use in data logs.
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Check the Conductivity Calibration

The conductivity sensor in the Aqua TROLL has been calibrated duringmanufacturing to produce a
linear response across the operating range.

We recommend you check the specific conductivity reading in the solution shipped with your
instrument. If the device is reading accurately, there is no need to fieldcalibrate the instrument
unless SOPs require it.

To perform a field calibration you will need:

l The In-Situ Cal Cup, or other suitable container that allows for complete immersion of the
conductivity sensor, including the temperature “button,” which can be seen on one side of the
probe. The Cal Cup is recommended for the first calibration.

l The calibration standard solution supplied, or other solution of known specific conductivity in
the range 100 to 60,000 μS/cm.

The complete calibration procedure takes only a few minutes andmay be done in a field or
office/lab setting with a software connection inWin-Situ 5 orWin-Situ Mobile Software. See
"Calibration" on page 32 for calibration instructions, including:

l Preparation of the Aqua TROLL

l Software input

l Calculated output

Prepare to Log Data

1. To program the device to log data, go to the Logging tab.

2. Click the “New” button.

TIP:Stop “polling” in the Home screen before setting up a data log.

TIP: Formore complete information on setting up data logs, see theWin-Situ Helpmenu.
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The Logging SetupWizard will guide you through the configuration of a data log—including the site, log name, parameters to
measure, sample schedule, start time, stop time, level output, and other options.

Tips for Aqua TROLL Data Logs

l Nine parameters are available for the Aqua TROLL 200 Instrument. Seven parameters are available for the Aqua
TROLL 100 Instrument. All selected parameters are logged, with implications for battery andmemory usage.

l Only one active log can reside in the device at a time. An active log is a log that is Ready, Pending, Running, or
Suspended as shown in the Status column of the Logging Tab.

l To avoid draining the Aqua TROLL battery prematurely, external power is required for Event logging, and
recommended for Linear Average logging.

l For information on selecting a Level output, refer to theWin- Situ Helpmenu, or see "Pressure and Level" on page
38 in this manual.

l For a non-vented Aqua TROLL that will be deployed on wire, be sure to select a Scheduled Start so the log will
start by itself, without a communication connection.

l Formore complete information on setting up data logs, see theWin-Situ Helpmenu .

To Start logging:

l A “Pending” (scheduled) log will start at its programmed time.

l You can start a “Ready” (manual) log at any time while connected by selecting the log and pressing “Start” .

To Stop logging:

l Select the log and press the “Stop” button .

l Or suspend (temporarily stop) it with the “Pause” button .

To Download the log to the connected PC:

l Select the log and press the “Download” button .

To View the log after downloading:

l Go to the Data tab and select the log; for a graph press .
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Importing VuSitu Data to Win-Situ

You can import data files from VuSitu intoWin-Situ 5 from the File menu.

A. Click File >  Import VuSitu CSV in the menu bar at the top
of the screen.

B. Select the file you wish to import and click Open.

C. Select OK at the prompt. D. Click on the file name to view it.
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Disconnect

After the Aqua TROLL is programmed to log data, you are ready to:

l Exit the software (File menu > Exit).

l Disconnect the TROLLCom from the cable connector, by grasping the textured section of the cable connector in
one hand and the TROLLCom in the other. Twist in opposite directions to unlock the TROLLCom from the cable.

l Vented cable: Attach desiccant to the cable connector—line up the flat sides of the connectors, push, twist, and
click to lock the desiccant to the cable. Remove red dust cap from the desiccant’s vent.

l Non-vented Aqua TROLL (or installations where vented pressure or communication are not required): Attach a
nonvented cable or twist-lock hanger and suspension wire.

l Install the instrument in its field location. See "Field Installation" on page 43 for guidelines.

Tips: Remove the dust cap from the desiccant before deployment to allow air to reach the cable vent tube.

Conductivity

About Conductivity

Conductivity measures the ability of amaterial to carry an electric current. Generally, the higher the concentration of
dissolved salts andminerals in water, the better the water is as a conductor, therefore the electrical conductivity is higher.
Deionized/distilled water is a poor conductor because almost all anions and cations are removed during the deionization/
distillation process. If conductivity changes in a body of water, it often indicates an environmental event. For example, a
dramatic increase in the electrical conductivity of an underground fresh water aquifer located near the ocean could indicate
the beginning of saltwater intrusion. On the other hand, an increase in the electrical conductivity of a small lake that is
completely surrounded by farmlandmay simply be the result of runoff from recent precipitation.

How is Conductivity Measured

Conductance is the reciprocal of the resistance, in ohms, measured between two opposing electrodes of a 1 cm cube at a
specific temperature. The unit 1/ohm ormhowas given the name of Siemens (S) for conductance. It is not practical to require
all conductance cells to have the dimensions of an exact cube. To enable the comparison of data from experiments with
different conductance cells, the conductance is multiplied by the cell constant to show conductivity in Siemens per
centimeter (S/cm). Cell constants are determined for each sensor using a standard solution of known conductivity. The cell
constant depends on the electrode area and the amount of separation or distance between the electrodes.

The four-electrode conductivity cell contains two drive electrodes and two sensing electrodes. In the Aqua TROLL
instrument, each drive electrode is composed of two interconnected pins, for a total of six pins. The sensing electrodes are
positioned in a low current area tominimize electrode fouling. An alternating current is used to drive the cell. This reduces
errors caused by polarization resulting from the application of a direct current.

Calibration

The conductivity sensor in the Aqua TROLL instrument has been calibrated duringmanufacturing to produce a linear
response across the operating range. Standard Operating Procedures for measuring conductivity in the field typically specify
that the sensor shall be calibrated before use, close to the expected temperature and conductivity conditions. The accuracy
of the sensor depends on the calibration solution used and the operator’s technique.

We recommend that you check the specific conductivity reading in the solution shipped with your instrument. If the device is
reading accurately, there is no need to field-calibrate the instrument unless SOPs require it.

The Aqua TROLL instrument can be calibrated at any point in the operating range. However, best results will be obtained in
the range of approximately 100 to 60,000microSiemens/cm (μS/ cm).

When carbon dioxide from the air dissolves into water it increases the conductivity, sometimes by as much as one or two
μS/cm. This could shift a 146.9 standard by as much as 3%. The amount of shift is not predictable, so it should beminimized
by limiting exposure to air. Fill the calibration cup to themarked fill line and close it as soon as possible. A small air bubble in
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the cup is acceptable, and in fact it assists mixing during the inversions. Discard remaining portions of low range calibration
standards within a few days after opening the bottle.

To perform a conductivity calibration of the Aqua TROLL Instrument you will need:

l The In-Situ Cal Cup supplied with your instrument.

l The calibration standard solution supplied, or other solution of known specific conductivity in the range 100 to
60,000 μS/cm.

Preparing to Calibrate

Three factors are essential to a successful conductivity calibration:

l A The calibration solution is not diluted or contaminated.

l B The probe and the solution are at the same temperature.

l C The sensing cell is completely filled with solution—no air bubbles on the sensor.

The following preparation steps can help to ensure a successful calibration and avoid erroneous field data.

A Eliminate water and rinse

1. Remove the nose cone (Aqua TROLL 200 only). Water trapped here can dilute the calibration solution. Air bubbles may
also come from this area.

2. If the device is wet from previous use, dry the body and shake to clear any liquid inside the conductivity
sensor.

3. Before opening the solution bottle, invert it a few times to redistribute any water condensation.

4. Remove the Cal Cup cap and fill the cup to the “Rinse” line with calibration solution.

5. Insert the Aqua TROLL through the grommet in the cap.

6. Attach the cap to the Cal Cup. The Aqua TROLL should rest on or near the bottom.

7. Shake vigorously to rinse the sensing cell.

8. Loosen the cap, remove the Aqua TROLL. There is no need to pull it out of the cap. Discard the solution.

9. For best results, rinse again using the same procedure.

B Equalize temperature

1. Fill the Cal Cup to the “Fill” line with calibration solution.

2. Install the Aqua TROLL and tighten the cap.

3. Invert multiple times for at least 30 seconds— longer if the probe and solution are at different temperatures.

C Remove air bubbles from the sensor

1. Hold the Aqua TROLL and the Cal Cup at a 45 degree angle.

2. Gently tap the Aqua TROLL against the inside of the Cal Cup to remove bubbles from the conductivity cell.

3. Repeat until all bubbles are removed.
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TIP:With the correct fill level, and the instrument held at a 45° angle, the air bubble in the Cal Cup will not intrude into the
conductivity sensor.

Note: Sometimes dissolved gases in the solution will cause bubbles to form on the sensor, especially if the solution is cold.
Thermal equilibriummay require extra time, and air bubbles may need to be removed before starting the calibration. If you can
see bubbles on the inside of the Cal Cup, bubbles are probably on the sensor.

Calibration Procedure

TIP: For best results when calibrating a completely dry sensor, allow it to soak for 15minutes in the calibration solution
before proceeding.

1. If you have not already done so, attach the cable to the Aqua TROLL Instrument and to the computer, openWin-Situ
Software, and connect to the device.

2. Go to the Sensors tab and select the sensor.

3. Click the “Calibrate” button .

4. In the next screen, select the Conductivity parameter and click Calibrate...
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After a review of the preparation steps the Conductivity Calibration screen appears.

5. Enter the Specific Conductivity of the calibration solution into the box next to μS/cm@25° C.

6. Click Start Calibration. Software will monitor the conductivity and temperature readings, calculate the cell constant
(sometimes called the “Kcell”), and inform you when the responsemeets the criteria for Nominal Stability.

7. You can click Accept... at any time to continue. For best results, wait until Full Stability is reached. At that time, the next
screen is displayed automatically.

8. Look at the Proposed Cell Constant before you Commit the value to the sensor. It should be in the range of 0.90 to 1.10.
Note: Aging sensors may display values between 0.70 and 1.30. If outside this range, we recommend returning to the factory
for calibration.

If the cell constant is out of range, the cause could be an air bubble, incomplete rinsing,
sensor fouling, or other factors. Repeat the preparation and calibration with fresh cal
solution.

9. When you are satisfied with the proposed cell constant, click Commit to write the
calculated cell constant to the sensor.

10. If the Aqua TROLLwill be deployed immediately, remove it from the Cal Cup, rinse
it, discard the calibration solution, and reinstall the black nose cone. Otherwise, store it
wet in the Cal Cup (in cal solution or water) for later deployment.

TIP: If the proposed cell constant is outside the range 0.90 – 1.10, check
conditions and repeat the calibration.

Nominal Stability vs. Full Stability

Tomeet the criteria for a valid calibration point, the change in sensor response is
monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a
specific time period. The criteria for Full Stability are designed tomeet the published specifications. The criteria for Nominal
Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

Available Parameters

The Aqua TROLL Instrument can also calculate and record derived parameters as listed below. For more information on
measurement methodology, including the equations used to derive the calculated parameters, see the technical note “Aqua
TROLL 200Measurement Methodology” on the In-Situ software/resource CD, or on the In-Situ web site at www.In-Situ.com.

Actual Conductivity

Units: micro siemens per centimeter (μS/cm), default milli siemens per centimeter (mS/cm)
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Specific Conductivity

A means of expressing what the actual conductivity of a solution would be at a standard reference temperature (25° C).
Calculated from actual conductivity and temperature. The factory default coefficients calculate specific conductivity per
StandardMethods 2510B.

Units: micro siemens per centimeter (μS/cm), default milli siemens per centimeter (mS/cm)

Salinity

Calculated from actual conductivity and temperature.
Units: Practical Salinity Units (PSU)

Total Dissolved Solids (TDS)

Calculated from specific conductivity using a conversion factor (Default: 0.65).

The TDS conversion factor may be edited inWin-Situ as follows: Select the sensor on the Sensors tab and click Configure

. In the next screen select the Total Dissolved Solids parameter and click Configure. Enter a value between 0.001
and 10.000. Units: parts per thousand (ppt), default parts per million (ppm)

Resistivity

Resistivity is the reciprocal (inverse) of the actual conductivity, which is useful whenmonitoring pure water. Units: ohms-cm

Density of Water

Calculated from salinity and temperature. Units: g/cm3

TIP:Parameter configuration is not available if the device is polling or has an active log.

TIP:Measured density values may be used to dynamically compute specific gravity whenmeasuring Level. View Win-
Situ Help or see "Pressure and Level" on page 38 of this manual for more information.

Shallow Deployment

When deploying the Aqua TROLL Instrument in shallow water, bubble formation on the conductivity sensor can create false
readings. We recommend the following tominimize the formation of bubbles:

Surface water: Gently agitate the instrument. Natural water flow will help to prevent bubbles.

Groundwater well or any location without flowing water, or where the instrument cannot be seen:

1. Lower the Aqua TROLL until it is below the surface of the water. (Tip: This can be determined if not visible by monitoring
the pressure/depth readings.)

2. Allow the conductivity sensor to be thoroughly wetted (at least 30 seconds).

3. Briskly agitate up and down several times, while not taking the device above the water surface.

4. When the conductivity readings stabilize, the Aqua TROLL is ready for deployment.

Maintenance and Recalibration

The need to clean the sensor is determined by the site conditions, and the accuracy you want to obtain from the instrument.
For example, when used in relatively clean water of low biological productivity, a conductivity sensor couldmaintain its
accuracy specifications for several months. On the other hand, in water with a high potential for biological or mineral fouling,
the sensor may need to be cleaned and re-calibratedmore often. Visual inspection andmeasurement results are the best
indicators that a device needs service recalibration.

It is the user’s responsibility to develop and follow amaintenance program appropriate to the site. Most standard operating
procedures (SOPs) instruct that the instrument be checked in a known standard at the end of a deployment. Calibration
should always be checked after cleaning, and should be recalibrated when necessary.

For specific cleaning procedures, see "Care andMaintenance" on page 53.



1-970-498-1500 37 www.in-situ.com

Factory recalibration of the Aqua TROLL 200 Instrument should be performed every 12-18months. See "How to Contact Us"
on page 5 for In-Situ's contact information.
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Install the Software

Install Win-Situ 5 Software from the In-Situ software/resource CD or from the In-Situ website:

l Click onWin-Situ 5, and follow the instructions to install Win- Situ 5 to your local hard drive.

USB TROLL Com Drivers

If using a USB TROLLCom, be sure to select the option "Install USB TROLLCom Drivers." Two drivers will be loaded to
your hard drive, one for the USB TROLLCom, one for the USB TROLLCom serial port.

Pressure and Level

The Aqua TROLL 200 Instrument contains a pressure sensor. A pressure transducer senses changes in pressure, measured
in force per square unit of surface area, exerted by water or other fluid on an internal media-isolated strain gauge. Common
measurement units are pounds per square inch (psi) or newtons per squaremeter (pascals).

Non-Vented (Absolute) vs. Vented (Gauged) Sensors

A non-vented or “absolute” pressure sensor measures all pressure forces exerted on the strain gauge, including atmospheric
pressure. Its units are psia (pounds per square inch “absolute”), measured with respect to zero pressure.

Non-vented pressuremeasurements are useful in vacuum testing, in short-term testing when atmospheric pressure would
not be expected to change, in very deep aquifers where the effects of atmospheric pressure are negligible, and in unconfined
aquifers that are open to the atmosphere.

With vented or “gauged” pressure sensors, a vent tube in the cable applies atmospheric pressure to the back of the strain
gauge. The basic unit for ventedmeasurements is psig (pounds per square inch “gauge”), measured with respect to
atmospheric pressure. Vented sensors thus exclude the atmospheric or barometric pressure component.

This difference between absolute and gaugedmeasurements may be represented by a simple equation:

Pgauge = Pabsolute – Patmosphere

Pressure, Depth and Level

Output options for pressuremeasurement are completely software-selectable. Each log configuration presents the following
choices:

l Pressure in psi or kPa

l Depth in feet or meters

l Water Level with a reference (an “offset”)

l Surface Elevation: positive up

l Depth toWater (drawdown): positive down

For Depth and Level, the software presents additional options:

l The type of measurement you intend to log (the “output”)

l The Level Reference you intend to use

l The specific gravity of the water in which the device will be deployed:

l Choose a fixed value for fresh, brackish, or saline water, or

l Enter a custom specific gravity value, or

l Choose Fixed density with gravitational compensation for a pressure-to-level conversion that
compensates pressure readings for fluid density and local gravitational factor (based on your latitude
and elevation), or
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l Choose Dynamic density with gravitational compensation, which will allow the software to
dynamically compute specific gravity using density measured by the conductivity sensor and local
gravitational factor.

Configuring Depth and Level

This procedure stores the configuration settings in the Aqua TROLL Instrument. When setting up a log, the same options are
presented.

1. While connected to the instrument in software, click the Sensors tab.

2. Select the sensor and click the Configure button .

TIP:When you configure level using the Sensors tab, the settings are stored in the Aqua TROLL Instrument and are
available for use inModbus, SDI-12, and analog communications, as well as inWin-Situ. Different configurations may be
selected when setting up a log.

TIP:Go to the Home tab and stop polling before configuring any sensor parameter.

3. In the Sensor Setup window, select the Level parameter, then click Configure...

The Level parameter shown is the one currently stored in the device. This is the default or themost recent choice. You will
have a chance to change the parameter later.



1-970-498-1500 40 www.in-situ.com

TIP:Parameter configuration is not available if the device is polling or has an active log.

4. In the Level SetupWizard, select the options you want. Each choice includes an illustration to assist you in selecting the
output. For more information, see Help inWin-Situ 5 Software.
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Pressure Sensor Calibration

Factory Recalibration

Pressure sensor accuracy can be adversely affected by improper care and handling, lightning strikes and similar surges,
exceeding operating temperature and pressure limits, physical damage or abuse, as well as normal drift in the device’s
electronic components. Aside from damage to the sensor, the need for factory recalibration is dependent upon the amount of
drift a customer is willing to tolerate. Factory calibration every 12-18months is recommended. Contact In-Situ Customer
Service for information on the factory maintenance and calibration plan.

Field Recalibration

The following proceduremay be used, with caution, to set to zero the offset of a vented pressure sensor to correct for
electronic drift. The drifted offset is visible when the sensor is in air and reading other than zero. It is recommended you do not
set to zero the offset if it is outside the specified accuracy of your pressure sensor, as shown in the table below. If the reading
in air deviates from zero by more than the amounts shown, youmay want to consider a factory recalibration.

Sensor Range Accuracy
(0°C to +50°C)

Acceptable Offset from
Zero

5 psi ± 0.1% FS ± 0.005 psi
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15 psi ± 0.1% FS ± 0.015 psi

30 psi ± 0.1% FS ± 0.03 psi

100 psi ± 0.1% FS ± 0.10 psi

300 psi ± 0.1% FS ± 0.30 psi

500 psi ± 0.1% FS ± 0.50 psi

Field Recalibration Procedure for a Vented Sensor

1. With the Aqua TROLL connected in software, go to the Sensors tab.

2. Select the pressure sensor and click the Calibrate button .

3. Select the Pressure parameter and click Calibrate...

4. Select Zero the Level/Pressure sensor. Make sure the device is dry and exposed to air.

5. Click OK . The software will inform you when the pressure reading is set to zero.

Barometric Compensation of Non-Vented Pressure & Level Data

Win-Situ® BaroMerge™ software can post-correct absolute (nonvented) level sensor data to eliminate barometric pressure
from themeasurements. BaroMerge provides three options:
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Fixed Correction – A single offset value is applied to all selected log data. Use this option if you know what the barometric
pressure was during the log, and know that it did not change.

Manual Entry – Specify two or more correction values to apply to the log data. Use this option if you know that barometric
pressure changed during the log.

BaroTROLL® Instrument log file – Absolute level sensor data are corrected by barometric pressure values logged by an In-
Situ BaroTROLL Instrument during the approximate time period.

Launching Baro Merge Software

BaroMergemay be opened as a stand-alone application from the program group In-Situ Inc., or accessed fromWin-Situ’s
Tools menu when both are installed on the same system.

Input

In the Fixed Correction andManual Entry options, it is important to know the barometric pressure for the general time period
covered by the log or logs you want to correct.

BaroMerge uses aWizard-like interface consisting of threemain steps:

1. Select the type of compensation/correction you intend to use.

2. Select the absolute (non-vented) log file or files you intend to correct. BaroMerge displays these automatically.

3. Click OK and the barometric compensation is applied.

Output

The original log file is not changed. A new, corrected log file with the same name and path is created. The original “.wsl”
extension is replaced by “-BaroMerge.wsl”.

For help on usingWin-Situ BaroMerge, press F1 at any BaroMerge screen.

For more detailed information on barometric compensation, see the technical notes on the In-Situ software/resource CD, or
www. in-situ.com.

Field Installation

Positioning the Vented Aqua TROLL 200 Instrument

Positioning the Vented Aqua TROLL 200 Instrument For unattended deployment, lower the Aqua TROLL 200 Instrument
gently to approximately the desired depth. Position the instrument below the lowest anticipated water level, but not so low
that its rangemight be exceeded at the highest anticipated level. Refer to the tables below for usable depth.

Do not let the instrument fall freely into the water because it can damage the pressure sensor.

Vented Aqua TROLL Instrument

Range Usable Depth

psig kPa Meters Feet

5 34.5 3.5 11.5

15 103.4 11 35

30 206.8 21 69

100 689.5 70 231
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300 2068 210 692

500 3447 351 1153

Non-Vented Aqua TROLL Instrument

Range Effective Range* Usable Depth

psia psia kPa Meters Feet

30 15.5 106.9 11 35

100 85.5 589.5 60.0 197

300 285.5 1968 200 658

500 485.5 3347 341 1120

* At sea level (14.5 psi atmospheric pressure).

Check Instrument Depth

At this point, if convenient, you can connect the Aqua TROLL 200 to a PC, launch the software, and take a reading. If the
instrument is at the desired depth, secure it in position as suggested below, or reposition as necessary.

If you set the software to “Remindme later” to set a Level Reference, enter the level reference after installation when
prompted.
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Secure the Cable

The RuggedCable includes a Kellems® grip near the surface end. You can slide it along the cable
to the desired position by compressing it. When you pull on it, the grip tightens and stops sliding.
Youmay need to pull on both ends of the Kellems grip to properly tighten it and keep it from
slipping.

Use the loop of the Kellems grip to anchor the cable to a convenient stationary object. It works
well with In-Situ’s well dock installation ring. Simply insert the loop into the locking clip on the well
dock, and position the assembly on the top of a well.

Installation Tips

l Never let a probe fall freely down awell. The resulting shock wave when it hits the water surface
can damage the strain gauge.

l Check the level of water above the probe, thenmove it and read again to be sure that the probe
presents a reasonable reading and shows change. It might not be located where you think it is. For
example, it could be wedged against the casing with a loop of cable hanging below it. A probe in
such a positionmight become dislodged andmove while logging, giving a false change in level. A
secure placement is critical to accuratemeasurements.

l Do not allow the vented cable to kink or bend. If the internal vent tube is obstructed, water level
measurements can be adversely affected. The recommendedminimum bend radius is 13.5mm
(0.54 in), which is twice the cable diameter. Theminimum bend radius for vented cable is 13.5mm
(0.54 in).

l For accuratemeasurements, the instrument should remain immobile while logging data.

l Be sure the uphole cable end is capped—desiccant on the vented cable connector, soft dust cap
on non-vented cable— and positioned above the highest anticipated water level. Avoid areas that
may flood when using vented cable.

TIP: Theminimum bend radius for vented cable is 13.5mm (0.54 in).

TIP: Do not submerge the cable connector; do not immerse in any fluid.

TIP:Be sure to replace the desiccant before it appears pink. Expired desiccant can allow moisture build up in
the vent tube, causing a blockage resulting in inaccurate data.

TIP: Do not deploy pressure transducers such that icemay form on or near the sensor or cable connections. Ice
formation is a powerful expansive force andmay over-pressurize the sensor or otherwise cause damage. Any
damage associated with ice formation is not covered by the warranty.

Stabilization Time

Allow the Aqua TROLL Instrument to stabilize to the water conditions for about an hour before logging data. A generous
stabilization time is always desirable, especially in long-term deployments. Even though the cable is shielded, temperature
stabilization and stretching can cause apparent changes in the level reading. A completely dry conductivity sensor may need
a few minutes settling time after initial immersion. If you expect to monitor conductivity and water levels at the highest
accuracy possible for the instrument, allow stabilization time.

Shallow Deployment

When deploying the Aqua TROLL Instrument in shallow water, bubble formation on the conductivity sensor can create false
readings. We recommend the following tominimize the formation of bubbles:

Surface water: Gently agitate the instrument. Natural water flow will help to prevent bubbles.

Groundwater well or any location without flowing water, or where the instrument cannot be seen:
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1. Lower the Aqua TROLL until it is below the surface of the water. (Tip: This can be determined if not visible by monitoring
the pressure/depth readings.)

2. Allow the conductivity sensor to be thoroughly wetted (at least 30 seconds).

3. Briskly agitate up and down several times, while not taking the device above the water surface.

4. When the conductivity readings stabilize, the Aqua TROLL is ready for deployment.

Installation of a Non-Vented Aqua TROLL

Aqua TROLL 100 and non-vented Aqua TROLL 200 instruments do not require vented cable for proper operation.
They may be deployed on non-vented RuggedCable or with a twist-lock hanger and stainless steel suspension wire.

l Because the twist-lock hanger has no communication capabilities, program the Aqua TROLL in advance, and
download the data the sameway.

l Logged pressure data will show the effects of changes in barometric pressure (unlike vented Aqua TROLL 200
sensors). However, post-processing tools such as Win- Situ BaroMergemay be used to eliminate the effects
of barometric pressure changes from the data, if required.

TIP:Be sure to program a non-vented Aqua TROLL before attaching the twist-lock hanger, as this accessory
has no communication capability.

TIP: DONOT submerge a non-vented Aqua TROLLwithout first attaching a twist-lock hanger, or a cable,
because the unit could be damaged by flooding.

Analog, SDI-12 and Modbus Connections

The Aqua TROLL instrument may be connected to a controller or logger for communication via:

l Analog 4-20mA (provides a configurable 4-20mA current loop output)

l SDI-12

l RS485Modbus

l RS232 toModbus (with a customer-supplied converter)

Stripped-and-tinned cable has a female twist-lock connector on one end to connect with the Aqua TROLL Instrument. The
uphole end terminates in bare wires for connection to a PLC or data logger.

A shorter cable ending in amale twist-lock connector to connect with RuggedCable is also available.
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Desiccant

Vented cablemust be installed with outboard desiccant to protect the cable
vent tube and Aqua TROLL electronics from condensation in high-humidity
environments.

The desiccant may be removed from the vent tube, if needed, to trim the
conductor wires. Pull the vent tube extender off the cable vent tube to
remove, replace desiccant after trimming and connecting the wires.

Wiring

Refer to diagrams on the following pages. Trim back and insulate unused
wires. The shield should be wired to a chassis ground or earth ground.

Signal Color Pin

Gnd/Return BLACK 6

Ext Power RED 5

4-20 mA BROWN 4

RS485(–) GREEN 3

RS485(+) BLUE 2

SDI-12 WHITE 1
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Power Connections

The red wire provides power for all Aqua TROLL communicationmodes. Analog output is disabled by default. However, the
4-20mA current loop output can be continuous inModbus or SDI-12mode as long as Modbus device register 49507 is set to
1. This can be done with a connection inWin-Situ by selecting the Device Setup tab, Analog Setup button, and enabling
analog output.

Communications

The device automatically switches betweenModbus and SDI-12modes depending on which of the two interfaces has
activity. Modbus and SDI-12 cannot be used at the same time—whichever one is currently in use will block communication
on the other.
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Using Win-Situ Software

Win-Situ provides options for configuring analog/SDI-12 communications (Setup tab) andModbus communications (File
menu > Settings). In addition, the Aqua TROLL Instrument is capable of internal logging (programmed inWin-Situ) while
participating in aModbus, SDI-12, or analog network. However, Win-Situ cannot communicate with the Aqua TROLL
Instrument while it is transmittingModbus, SDI-12, or analog data, and conversely, the instrument cannot receive or respond
toModbus, SDI-12, or analog commands while connected to a PC serial port.

Redundant Logging Feature

l If the PLC or recorder somehow loses data, the Aqua TROLL data can be retrieved usingWin-Situ.

l If the PLC or recorder ceases to function due to power loss, the Aqua TROLLwill continue to collect data using its
own internal batteries and clock.

A port-powered RS485 converter like that shown for Modbus connections may be used for temporary connection of the Aqua
TROLL to a serial port on a PC.

For More Information

For additional information onModbus and SDI-12 communications, including the SDI-12 commands andModbus registers,
see these In-Situ technical notes:

l SDI-12 Commands and Aqua TROLLResponses.

l In-Situ Modbus Communication Protocol.

They are available on the In-Situ software/resource CD and at www.in-situ.com.

Care and Maintenance

Operating Considerations

The Aqua TROLL Instrument has been designed to withstand harsh field conditions. However, as with any electronic
instrument, it can be permanently damaged if used outside its operating specifications.

Temperature

The Aqua TROLL temperature sensor operates within a temperature range of -5° to 50° C (23° to 122° F) in non-freezing fluid.

Pressure Range

The Aqua TROLL 200 Instrument can withstand pressures of up to two times (2X) the rated range of the pressure sensor
without damage, although it may not read correctly at such pressure. If the pressure range is exceeded by 3X, the pressure
sensor will be destroyed.

Factory Calibration

Accuracy can be adversely affected by improper care and handling, lightning strikes and similar surges, exceeding operating
temperature and pressure limits, physical damage or abuse. Factory calibration every 12-18months is recommended.
Contact In-Situ Customer Service for information on the factory maintenance and calibration plan.

Storage

Place the protective red dust cap on the cable end, or store with cable attached to protect the connector pins andO-ring.
Store the instrument where it will not fall onto a hard surface. Protect the instrument from temperature extremes. Store within
a temperature range of -40° C to 65° C (-40° F to 149° F). For best performance if stored dry, soak the conductivity cell in a
calibration standard for 48 hours prior to calibration and deployment.

General Maintenance

Twist-Lock Connectors
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Keep the pins on all connectors free of dirt andmoisture by using the soft protective dust cap when cable is not attached to an
instrument.

Do not submerge the cable connector; do not immerse in any fluid.

Cable Vent Tube (Vented Cable)

Vented cable ensures that atmospheric pressure is the reference pressure to the vented pressure sensor diaphragm. The
vent tube should not be blocked, kinked, or otherwise obstructed. Such obstructions will cause barometric pressure to appear
in measurements, and errors will be introduced due to thermal expansion and contraction of air within the vent tube and probe.

TIP: The recommendedminimum bend radius is 13.5mm (0.54 in), which is twice the cable diameter.

TIP:Be sure to replace the desiccant before it appears pink. Expired desiccant can allow moisture build up in the vent
tube, causing a blockage resulting in inaccurate data.

Batteries

Internal batteries in the Aqua TROLL Instrument are not user replaceable. The approximate percentage remaining is
displayed on theWin-Situ 5 Dashboard when the instrument is connected.

Cleaning

Probe and Front End

Clean the Aqua TROLLwith water and a soft brush or plastic scouring pad, or soak overnight in amild acidic solution, such
as household vinegar.

If the pressure ports of the Aqua TROLL 200 in the front end are clogged with silt or mud, try the following:

l Agitate the instrument vigorously in a bucket of clean water.

l Apply a gentle stream of water from awash bottle.

l In severe cases, remove the nose cone and clean out the holes with a soft brush or pipe cleaner.

Damage caused by digging or scraping in the pressure sensor opening to remove silt, mud, etc. is not covered by the
warranty.

To avoid damage to the pressure sensor diaphragm, do not insert any object into the sensor opening or attempt to dig out dirt
or other materials. If contamination cannot be removed using the recommendations above, please contact In-Situ Inc. for
cleaning.

When the nose cone is removed from the Aqua TROLL 200, the sensitive pressure sensor diaphragm is completely
exposed. Do not touch this area with any object. Replace the nose cone as soon as possible.

If contamination cannot be removed using the recommendations above, please contact In-Situ Inc. for cleaning.

Conductivity Sensor
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Fouling frommineral and biological sources can alter the sensor’s response.

l Rinse under running water to remove loosematerial.

l Always finish with a rinse in clean water.

l After cleaning, always check the calibration before redeployment, and recalibrate the sensor when necessary.

Acceptable cleaning processes fall into the following categories:

Process 1: Light scrubbing with a soft swab andmild soap such as a dilute solution of dish detergent. Be careful not to
damage the plastic material of the conductivity cell. Aqua TROLL Instruments are shipped with polyurethane foam swabs for
this purpose. You can also clean the conductivity cell using a thin cotton pipe cleaner and a a gentle back-and-forth motion.

Process 2: Light scrubbing with a foam swab and an aggressive soap such as Alconox detergent can be used for more
stubborn deposits.

Process 3:Dilute (10:1) acetic acid, or consumer-packaged white vinegar, can be used to pre-soften calcium deposits.
Follow this with Process 1 or Process 2, depending on the degree of residual contamination. The Aqua TROLL can soak for
any length of time in dilute acetic acid. If this does not completely remove thematerial, try Process 4.

Process 4:Dilute phosphoric acid (< 27%) or the consumer product Lime-A-Way® can be topically applied with a soft swab
to remove iron or calcium deposits that remain after using Process 3. Do not soak for more than 10minutes. Rinse well with
water.

If contamination cannot be removed using the recommendations above, please contact In-Situ Inc. (See page 5.)

TIP: Foam swabs are shipped with the Aqua TROLL Instrument; replacements are available from In-Situ Inc. (Catalog
No. 0056820).

TIP:Alconox is available from In-Situ Inc. (Catalog No. 0029810).

DONOT SOAK in phosphoric acid or Lime-A-Way® for more than 10minutes.

Troubleshooting

TROUBLESHOOTING CONNECTIONS

Problem:Win-Situ 5 Software cannot connect to the Aqua TROLL instrument.

Probable Cause: The wrong COM port is selected, communication settings are incompatible, batteries are low, or cable
connections are loose or dirty.

Suggested Remedy:Check the following:

l All cable connections are tight, connectors are clean and dry.

l The cable is securely attached to the instrument.

l The correct COM port is selected (select Preferences menu > Comm Settings to check this).

l The communication settings inWin-Situ and in the Aqua TROLLmatch. To reset the device communication
settings to the serial defaults, click “Reset all Devices” in the Comm Settings dialog (Preferences menu > Comm
Settings)

l The internal battery has voltage remaining or external power is supplied.

Problem:Real-time readings are in the wrong units.

Probable Cause:Default units are being used.

Suggested Remedy:Click the Sensors tab, select the sensor, click the Configure button , and select the desired

units for each parameter in the Sensor Setup window. Click OK . Be sure to stop “polling” in the Home screen before
selecting units.
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TROUBLESHOOTING DATA LOGS

Problem:Cannot add a new log.

Probable Cause 1:Only one active log can reside in the device at a time—an active log is a log that is Ready, Pending,
Running, or Suspended as shown in the Status column of the Logging Tab.

Suggested Remedy:Stop or delete the log if possible. Alternatively, configure the new log after the active log is completed.

Probable Cause 2: The device has its maximum number of logs already stored—although this is not a likely cause for the
Aqua TROLL 200, which has a capacity of 50 logs.

Suggested Remedy:Download, and then delete a log you are finished using. This will make room for an additional log on the
device.

Problem:New log exceeds available memory (message from software).

Probable Cause: The log as configured would exceed the devicememory.

Suggested Remedy:Edit the log and try these:

l Select a longer sampling interval.

l If available, select theWrap data option (current data will overwrite older data when thememory is full).

l For a log with a scheduled start, select None as the stop condition, or select a stop time that is closer to the start
time.

TROUBLESHOOTING PARAMETER CONFIGURATION

Problem:Cannot configure level or other parameters using the Configure button on the Sensors tab. The Sensor setup
screen is shown, but the Configure... button is dim.

Probable Cause 1: The Aqua TROLL is actively polling (continually updating real-time readings) in the Home tab.

Suggested Remedy: Return to the Home tab and stop real-time readings by clicking .

Probable Cause 2: The Aqua TROLL has an active log—a log that is Ready, Pending, Running, or Suspended as shown in
the Status column of the Logging Tab. Only one active log can reside in the device at a time.

Suggested Remedy:Stop or delete the log if possible. Alternatively, configure parameters after the log is completed.

TROUBLESHOOTING CONDUCTIVITY CALIBRATION

Problem: The calculated cell constant (Kcell) is lower than the recommended range of 0.98 – 1.02.

Probable Cause: The electrical resistance of the calibration solution was lower than expected for the nominal value.

Suggested Remedy:Check the following and then repeat the calibration:

l Visually inspect the sensor for the presence of fouling (most likely conductivematerial, possibly a bio-film); clean
as described in Section 9 of this manual.

l Ensure the calibration solution is not contaminated, mislabeled, or partially evaporated.

l Rinse the Aqua TROLL Instrument and the Cal Cup thoroughly with fresh calibration solution before calibrating.

Problem: The calculated cell constant (Kcell) is higher than the recommended range of 0.98 – 1.02.

Probable Cause: The electrical resistance of the calibration solution was higher than expected for the nominal value, or an
air bubble was present in the sensing cell during calibration.

Suggested Remedy:Check the following and then repeat the calibration:

l Visually inspect the sensor for the presence of fouling (most likely an obstructingmaterial or organism); clean as
described in Section 9 of this manual.

l Ensure the calibration solution is not contaminated, mislabeled, or partially diluted.

l Rinse the Aqua TROLL Instrument and the Cal Cup thoroughly with fresh calibration solution before calibrating.
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l “Roll and tap” the Aqua TROLL Instrument in the Cal Cup to dispel air bubbles as described and illustrated in
Section 5.

Declaration of Conformity

Manufacturer: In-Situ, Inc.

221 East Lincoln Avenue

Fort Collins, CO 80524 USA

Declares that the following product:

l Product name: Aqua TROLL

l Model: Aqua TROLL 200

l Product Description: The Aqua TROLL 200measures and logs level, temperature, and conductivity in natural
groundwater and surface water.

is in compliance with the following Directives:

l 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 73/23/EEC for Safety Directive

andmeets or exceeds the following international requirements and compliance standards:

l Immunity
EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

l Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

Supplementary Information:

The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE mark is affixed
accordingly.

Bob Blythe

Declaration of Conformity

Manufacturer: In-Situ, Inc.

221 East Lincoln Avenue

Fort Collins, CO 80524 USA

Declares that the following product:

l Product name: TROLLCom

l Model: USB TROLLCom Product Description: RS485 to USB converter

is in compliance with the following Directive

l 89/336/EEC for Electromagnetic Compatibility (EMC) Directive 73/23/EEC for Safety Directive

andmeets or exceeds the following international requirements and compliance standards:

l Immunity
EN 61326, Electrical Equipment for Measurement, Control and Laboratory Use, Industrial Location
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l Emissions
Class A requirements of EN 61326, Electrical Equipment for Measurement, Control and Laboratory Use

Supplementary Information:

The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE mark is affixed
accordingly.

Todd Campbell

New Product Development ProgramManager

In-Situ, Inc.

June 17, 2006

The presence of theWaste Electrical and Electronic Equipment (WEEE)marking on the product
indicates that the device is not to be disposed via themunicipal waste collection system of any
member state of the European Union.

For products under the requirement of WEEE directive, please contact your distributor or local In-
Situ Inc. office for the proper decontamination information and take back program, which will
facilitate the proper collection, treatment, recovery, recycling, and safe disposal of the device.
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